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บทที ่3 
การด าเนินงาน 

 
ในบทน้ีจะกล่าวถึงรายละเอียดอุปกรณ์และส่วนประกอบของกระบวนการ,   รายละเอียดของ 

โปรแกรมแลปวิวเพื่อใชใ้นการควบคุมกระบวนการ, ขั้นตอนการท างานของกระบวนการควบคุม
ระดบัน ้ำและขั้นตอนกำรควบคุมแบบพีไอดีและฟัซซี  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที ่3.1  ขั้นตอนกำรด ำเนินงำน 
 

เร่ิมงำน 

ศึกษำขอ้มูลแลว้จดัวำงขั้นตอน 

จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ 

1 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

ออกแบบโครงสร้ำงถงัน ้ำ 

ผำ่น 

ไม่ผำ่น 
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รูปที ่3.1  ขั้นตอนกำรด ำเนินงำน(ต่อ) 
 

2 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

ประกอบโครงสร้ำงถงัน ้ำ 

1 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

ออกแบบชุดไมโครคอนโทรลเลอร์ 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ 
 

ผำ่น 

ไม่ผำ่น 

ผำ่น 

ไม่ผำ่น 

ผำ่น 

ไม่ผำ่น 
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รูปที ่3.1  ขั้นตอนกำรด ำเนินงำน(ต่อ) 
 

 

 

2 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

เขียนโปรแกรมโดยใช ้ LabVIEW 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

ทดสอบกำรท ำงำนของระบบ 
 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

สร้ำงชุดไมโครคอนโทรลเลอร์ 

3 

ผำ่น 

ไม่ผำ่น 

ผำ่น 

ไม่ผำ่น 

ผำ่น 

ไม่ผำ่น 
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รูปที ่3.1  ขั้นตอนกำรด ำเนินงำน(ต่อ) 
กำรด ำเนินกำรสร้ำงชุดสำธิตกำรควบคุมระดบัน ้ำดว้ยตวัควบคุมแบบพีไอดีและฟัซซี โดยใช้

โปรแกรมแลปววิมีขั้นตอนกำรด ำเนินงำนดงัต่อไปน้ี  
3.1  รายละเอยีดอุปกรณ์และส่วนประกอบของกระบวนการ 

ศึกษำรำยละเอียดวงจรท่ีเก่ียวขอ้งในโครงงำนน้ี และออกแบบโครงสร้ำงของถงัน ้ ำเพื่อใชใ้น
โครงงำนน้ีอยำ่งเหมำะสม ในกำรศึกษำไดข้อ้มูลจำกปริญญำนิพนธ์ กำรสร้ำงชุดสำธิตกำรควบคุม
ระดับน ้ ำด้วยตวัควบคุมแบบพีไอดีและฟัซซีโดยใช้โปรแกรมแลปวิวจะประกอบด้วยอุปกรณ์   
หลำยชนิดประกอบเขำ้ดว้ยกนัโดยจะแบ่งออกเป็นส่วนใหญ่ๆ ไดแ้ก่ 

3.1.1  บอร์ดไมโครคอนโทรลเลอร์ (Micro Controller) เบอร์ PIC18F4550 

3 

ผำ่น 

ไม่ผำ่น ปรับปรุงแกไ้ข ตรวจสอบ 

ท ำปริญญำนิพนธ์ 

 

 
ปรับปรุงแกไ้ข ตรวจสอบ 

ท ำคู่มือใชง้ำน 

จบ 

ผำ่น 

ไม่ผำ่น 
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3.1.2  กล่องใสบอร์ดไมโครคอนโทรลเลอร์ 
3.1.3  มอเตอร์ป๊ัม (Motor Pump ) 
3.1.4  วำลว์น ้ำ 3 ตวั 
3.1.5  เซนเซอร์ 2 ตวั 
3.1.6  ชุดถงัน ้ำ กวำ้ง 10 ซม. ยำว 10 ซม. และควำมสูง 30 ซม.  2 ถงั 
3.1.7  ถงัเก็บน ้ำ กวำ้ง 15 ซม. ยำว 30 ซม. และควำมสูง 15 ซม.  
3.1.8  ชุดโครงวำงถงัน ้ำ 
3.1.9  โปรแกรมท่ีใชเ้ขียนกำรรับ-ส่งค่ำ 
3.1.10  บอร์ดท่ีใชใ้นกำรเบิร์นโปรแกรม 
3.1.11  โปรแกรมแลปววิ เวอร์ชัน่ 8 
3.1.1  บอร์ดไมโครคอนโทรลเลอร์เบอร์ PIC18F4550   

 
 
 
 
 
 
 
 

รูปที ่3.2  ชุดบอร์ดไมโครคอนโทรลเลอร์เบอร์ PIC18F4550 
ชุดบอร์ดไมโครคอนโทรลเลอร์เบอร์ PIC18F4550 ท ำหน้ำท่ีในกำรรับสัญญำณจำก

เซนเซอร์แลว้แปลงจำก A/D ผำ่นทำงR เพื่อเขำ้โปรแกรม  แลปววิ 
 3.1.1.1  คุณสมบติั รองรับทั้ง USB 1.0/1.1 และ 2.0  
  ก)  รองรับกำรถ่ำยทอดขอ้มูลควำมเร็วต ่ำ 1.5 เมกะบิตต่อวนิำที และควำมเร็ว 

เตม็ท่ี 12 เมกะบิตต่อวินำที 
  ข)  รองรับกำรถ่ำยทอดขอ้มูลในแบบคอนโทรล (Control), อินเตอร์รัปต ์

(Interrupt), ไอโซโครนสั (Isochronous) และบลัก ์(Bulk)  
  ค)  รองรับอุปกรณ์ถึง 32 เอน็ดพ์อยต ์(16 เอนดพ์อยต ์ในกรณี 2 ทิศทำง)  
  ง)  หน่วยควำมจ ำแรม 1 กิโลไบต ์ส ำหรับส่วนติดต่อ USB เขำ้ถึงไดแ้บบคู่ 

(Dual Access)  
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  จ)  บรรจุตวัรับส่งขอ้มูล USB และวงจรควบคุมแรงดนัคงท่ี  
  ฉ)  น ำไปใชเ้ป็นส่วนเช่ือมต่อพอร์ต USB ใหแ้ก่อุปกรณ์ท่ีไม่มีส่วนติดต่อ

พอร์ต USB  
  ช)  สำมำรถจดักำรขอ้มูลพอร์ตขนำนเพื่อถ่ำยทอดในรูปแบบกำรจดักำรขอ้มูล

ของ USB  
 3.1.1.2  คุณสมบติัเด่นของวงจรก ำเนิดสัญญำณนำฬิกำ  

มี 4 โหมด รวมทั้งวงจรก ำเนิดสัญญำณนำฬิกำดว้ยคริสตอลแบบเฟสล็อกลูป
ควำมเท่ียงตรงสูง ส ำหรับส่วนติดต่อพอร์ต USB ซ่ึงเม่ือใช้งำนกับพอร์ต USB ต้องเลือกใช ้  
โหมดของสัญญำณนำฬิกำโหมดน้ี  
 ก)  สำมำรถเลือกใช้สัญญำณนำฬิกำภำยนอกได้ 2 โหมด ควำมถ่ีสูงถึง 48   

เมกะเฮิรตซ์ 
  ข)  วงจรก ำเนิดสัญญำณนำฬิกำท่ีสองใชไ้ทเมอร์ 1 ควำมถ่ี 32 กิโลเฮิรตซ์  
 ค)  สำมำรถเลือกสัญญำณนำฬิกำของกำรท ำงำนปกติกับโมดูล USB ให้มี 

ควำมถ่ีแตกต่ำงกนัได ้
        3.1.2  กล่องท่ีใชใ้นกำรใส่บอร์ดไมโครคอนโทรลเลอร์ 

 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.3  กล่องใส่บอร์ดไมโครคอนโทรลเลอร์ 

         วสัดุท่ีใช้ท ำคือกล่องอเนกประสงค์ เน่ืองจำกหำซ้ือง่ำยและรำคำถูกและมีลักษณะ
สวยงำมเหมำะแก่กำรน ำมำท ำเป็นชุดสำธิตกำรสอน 
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 สัญ ลักษ ณ์ ด้ ำนหน้ ำก ล่ อง น้ี ใช้ ก ำรพิ มพ์ จ ำก เค ร่ือ งพิ มพ์ และน ำม ำติดบน                  
กล่องอเนกประสงค์ ส ำหรับโปรแกรมท่ีใช้เขียนใช้โปรแกรม Illustrator ซ่ึงเขียนง่ำยเหมำะ         
แก่กำรเขียนรูปสัญลกัษณ์ต่ำงๆ จึงเลือกน ำมำใช ้

3.1.3  มอเตอร์ป๊ัม  
 
 
 
 
 
 

 
รูปที ่3.4  มอเตอร์ป๊ัมไฟฟ้ำกระแสตรง ขนำด 24 โวลต ์มีอตัรำกำรไหล 7 ลิตร/นำที 

ท ำหน้ำท่ีในกำรจ่ำยน ้ ำเขำ้ในถงัเม่ือระดบัน ้ ำลดลงจำกกำรก ำหนดโดยจะรับสัญญำณ-   
พีดบัเบิ้ลยูเอ็ม (PWM : Pulse Width Modulation) จำกชุดบอร์ดไมโครคอนโทรลเลอร์โดยใช ้
ไอซี L298 เป็นไอซี ชนิด Full Bridge Drive  

3.1.4  วำลว์น ้ำ 
 
 
 
 
 
 
 

รูปที ่3.5  วำลว์น ้ำ 
ท ำหนำ้ท่ีระบำยน ้ ำออกจำกถงัท่ี 1 และถงัท่ี 2 เพื่อให้ระดบัน ้ ำในถงัลดลงแลว้ปล่อยลงสู่

ถังเก็บน ้ ำและ ปล่อยน ้ ำจำกถังท่ี 1 เข้ำสู่ถังท่ี 2 เพื่อให้ระดับน ้ ำในถังมีระดับเท่ำกัน วำล์วน ้ ำ            
ท่ีเลือกใช้น้ีเน่ืองจำกสำมำรถหร่ีวำล์วได้และก ำหนดได้ว่ำจะเปิดอตัรำกำรไหลมำกหรือน้อยได้      
จึงเลือกใชว้ำล์วน ้ ำแบบใชมื้อหร่ี ซ่ึงต่ำงจำกโซลินอยด์วำล์วท่ีหร่ีวำล์วไม่ไดเ้รำจึงเลือกใชง้ำนเป็น
วำลว์น ้ำแบบใชมื้อหร่ี วำลว์น ้ำมีขนำด 1/8 น้ิว 
 3.1.5  เซนเซอร์ 
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รูปที ่3.6  เซนเซอร์ควำมดนัชนิดแผน่ไดอะแฟรม 
ท ำหน้ำท่ีตรวจสอบระดับน ้ ำในถังโดยสัญญำณท่ีได้จะออกมำเป็นแรงดันส่งเข้ำ          

ชุดบอร์ดไมโครคอนโทรลเลอร์ ควำมสัมพนัธ์ระหวำ่งระดบัน ้ำและควำมดนัแสดงไดด้งัสมกำร 

                                                 
Vg

P
A


                   (3.1) 

จำกสมกำรท่ี 3.1 จะเห็นได้ว่ำค่ำ  , g และ A เป็นค่ำคงท่ีทั้ งหมดดังนั้นควำมดันจึง 
แปรผนัตำมค่ำ V ซ่ึงเป็นปริมำตรของน ้ ำหำไดจ้ำก ควำมกวำ้งคูณควำมยำวคูณควำมสูง ซ่ึงควำม
กวำ้งและควำมยำวเป็นค่ำคงท่ี ดงันั้นควำมดนัจึงแปรผนัตำมค่ำควำมสูงของระดบัน ้ำ 

3.1.6  ชุดถงัน ้ำ  
 
 
 
 
 
 
 
 
 
 

 
รูปที ่3.7  ถงัน ้ำกวำ้ง 10 ซม. ยำว 10 ซม. และควำมสูง 30 ซม. 

ใช้แผ่นอะคิลิคแบบแผ่นมำประกอบเป็นถงัและใช้กำวซิลิโคนทำซ่ึงสำมำรถป้องกนั
กำรร่ัวซึมของน ้ำได ้เน่ืองจำกวสัดุมีน ้ำหนกัเบำจึงสำมำรถเคล่ือนยำ้ยไดส้ะดวก 

3.1.7  ถงัเก็บน ้ำ  
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รูปที ่3.8  ถงัเก็บน ้ำ กวำ้ง 30 ซม. ยำว 50 ซม. และควำมสูง 35 ซม. 
 ถงัเก็บน ้ ำท ำจำกแผ่นอะคลิลิคน ำมำประกอบกนัแลว้ทำดว้ยกำวซิลิโคนเพื่อป้องกนัน ้ ำ
ในถงัร่ัวซึม 

3.1.8  ชุดโครงวำงถงัน ้ำ  
 

 
 
 
 
 
 
 
 
 

 
รูปที ่3.9  กวำ้ง 70 ซม. ยำว 70 ซม. และสูง 60 ซม. 

 ชุดโครงวำงถงัน ้ ำท่ีเรำสร้ำงข้ึนมำท ำจำกอะลูมิเนียมโปรไฟล์ท่ีมีน ้ ำหนกัท่ีเบำสำมำรถ
เคล่ือนท่ีไดส้ะดวก 
      3.1.9  โปรแกรม CCS  
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รูปที ่3.10 โปรแกรม CCS 
 เป็นโปรแกรมท่ีใช้เขียนภำษำซีและตวัคอมไพเลอร์ ท่ีมีเฮดเดอร์ไฟล์ของตระกูล PIC   
ใหเ้ลือกใช ้

3.1.9.1 คุณสมบติัของโปรแกรม CCS C Compiler มีดงัน้ี 
 ก)  ตัวพัฒนำโปรแกรมหรือท่ี เรียกว่ำ IDE (Integrated Development- 

Environment) มีควำมสำมำรถสูง มีเคร่ืองมือ (Tools) อยู่ภำยในหลำย
ตวัท่ีช่วยอ ำนวยควำมสะดวกต่อนกัพฒันำโปรแกรมไดเ้ป็นอยำ่งดี 

ข)  มีฟังก์ชันช่วยเหลือท่ีติดมำกับตัวคอมไพเลอร์หรือท่ีเรียกว่ำ Built-In- 

Functions ท่ีจ  ำเป็นต่อกำรพฒันำงำนทำงด้ำนไมโครคอนโทรลเลอร์
จ ำนวนมำก 

ค)  มีตวัอยำ่งรองรับกำรเรียนรู้ส ำหรับผูเ้ร่ิมตน้ในทุกๆฟังกช์นักำรท ำงำน 
ง)  มีตวัช่วยอธิบำยฟังกช์นัต่ำงๆในส่วนของเมนู Help พร้อมค ำอธิบำย

ตวัอยำ่ง และตวัอยำ่งไฟลท่ี์เก่ียวขอ้งกบัฟังกช์นันั้นๆ 
 รองรับไมโครคอนโทรลเลอร์ PIC/dsPIC ทุกเบอร์ รวมทั้ งเบอร์ใหม่ๆ         
ท่ีจะเกิดข้ึน เพรำะมีกำรพฒันำตวัคอมไพเลอร์อยำ่งต่อเน่ือง 

 
 
 
 

 
 3.1.10  บอร์ดท่ีใชใ้นกำรเบิร์นโปรแกรม 
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รูปที ่3.11  บอร์ดท่ีใชใ้นกำรเบิร์นโปรแกรม 

 บอร์ดเบิร์นท ำหน้ำท่ีเขียนโค้ดค ำสั่งในโปรแกรม CCS ลงไปไปยงั PIC18F4550 
จุดเด่นของเคร่ืองโปรแกรม ET-PGMPIC USB ก็คือ กำรเช่ือมต่อท่ีเป็นแบบ USB ท ำให้ใชง้ำน
ไดส้ะดวกและ มีควำมเร็วในกำรโปรแกรมสูง ใชเ้วลำในกำรโปรแกรมสั้นลง นอกจำกน้ียงัสำมำรถ
อพัเกรดเฟิร์มแวร์เวอร์ชันใหม่ๆ จำกไมโครชิฟ  (www.microchip.com) ได้อีกด้วย นอกจำก
คุณสมบติัในขั้นตน้แลว้ ตวับอร์ดยงัมีชุดโมดูลเสริม ส ำหรับท ำกำรโปรแกรมแบบ Emulator ซ่ึง
สำมำรถโปรแกรมลง Target บอร์ดไดโ้ดยตรงสะดวกต่อกำรพฒันำโปรแกรมเป็นอย่ำงยิ่ง เพรำะ
ไม่ตอ้งคอยถอดขำไอซีเขำ้-ออก ลดควำมเส่ียงต่อกำรหกั หรืองอ ของขำไอซีได ้ 

3.1.11  โปรแกรมแลปววิเวอร์ชัน่ 8 
 
 
 
 
 
 
 
 
 

รูปที ่3.12  โปรแกรมแลปววิเวอร์ชัน่ 8 
 ท ำหน้ำท่ีตั้งค่ำจุดก ำหนด (Set Point) ของระบบ และประมวลผลขอ้มูลจำกเซนเซอร์
ใชต้วัควบคุมแบบพีไอดีและฟัซซี พร้อมทั้งแสดงผลระดบัของน ้ำออกทำงหนำ้จอคอมพิวเตอร์ 
3.2  การเขียนโปรแกรม 

3.2.1  กำรเขียนโปรแกรมภำษำซีควบคุมไมโครคอนโทรลเลอร์โดยใชโ้ปรแกรม CCS 
3.2.1.1  แปลงสัญญำณอนำลอกเป็นดิจิตอล 
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 โมดูลแปลงสัญญำณอนำลอกเป็นดิจิตอลของ PIC18F4550 จะมีควำมละเอียด
ในกำรแปลงสัญญำณขนำด 10 บิต ค่ำควำมละเอียดในกำรแปลงสัญญำณอนำลอกเป็นดิจิตอลมีค่ำ
ระหวำ่ง 0 ถึง 1023 โดยใชว้ธีิกำรแปลงสัญญำณแบบประมำณค่ำ (Successive Approximation) 

3.2.2  สร้ำงสัญญำณพีดบัเบิ้ลยเูอม็ 
 สัญญำณพีดบัเบิ้ลยูเอ็ม สำมำรถสร้ำงไดจ้ำกโมดูล CCP (Compare/Capture/PWM) 

โดยค่ำคำบเวลำจะข้ึนอยู่กับกำรก ำหนดค่ำ Timer2 เรำสำมำรถก ำหนดควำมถ่ีของสัญญำณ-           
พีดบัเบิ้ลยเูอม็ไดจ้ำกสมกำร 

 คำบเวลำของสัญญำณพีดบัเบิ้ลยเูอม็ (PWM Period)  

  = ( 2 1) 4 (1/ ) (Pr )PR Clock escaleValue     (3.2) 
*PR2 มีค่ำระหวำ่ง 0 – 255 

*Clock คือ ควำมถ่ีของคริสตลั (Crystal) 

*Prescale Value มีค่ำ (1, 4, 6) 
 ควำมถ่ีของสัญญำณพีดบัเบิ้ลยเูอม็ (PWM Frequency) 

 ควำมถ่ีของสัญญำณพีดบัเบิ้ลยเูอม็ = 1/คำบเวลำของสัญญำณพีดบัเบิ้ลยเูอม็         (3.3) 
 วฏัจกัรหนำ้ท่ีของสัญญำณ (Duty Cycle) = (Duty(%)(PR2+1)) (3.4) 
กำรสร้ำงสัญญำณพีดบัเบิ้ลยเูอม็ควำมถ่ี 5 กิโลเฮิรตซ์ มีค่ำ วฏัจกัรหนำ้ท่ี = 50 % 

คำบเวลำของสัญญำณพีดบัเบิ้ลยเูอม็ 1/ 5kHz  

                     
0.0002

( 2 1) 4 (1/ ) ( )

s

PR Clock PrescaleValue



    
 

ก ำหนดค่ำ Prescale Value = 16 

ดงันั้นค่ำ 

( )
2 1

(4 (1/ ) ( ))

200
1

(4 (1/ 20000000) 16)

61.5 61

PWM period
PR

Clock PrescaleValue

s

 
 

 
 

 

 

หลงัจำกไดค้่ำ PR2 แลว้จึงท ำกำรก ำหนดค่ำ Timer2 

setup_timer_2(T2_DIV_BY_16,61,1); 

* T2_DIV_BY_16 ไดม้ำจำกกำรก ำหนดค่ำ Prescale Value = 16 

*61 คือ ค่ำ PR2 

*1 คือค่ำ Postscale ในท่ีน้ีก ำหนดใหเ้ป็น 1 

ท ำกำรก ำหนดวฏัจกัรหนำ้ท่ีไดจ้ำกค ำสั่ง 
set_pwm1_duty(31); 
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*ค่ำ 31 ไดม้ำจำก (50 /100) (61 1)   

ทดลองท ำกำรวดัสัญญำณพีดบัเบิ้ลยเูอม็ท่ีวฏัจกัรหนำ้ท่ี 20% 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.13  สัญญำณพีดบัเบิ้ลยเูอม็ท่ีวฏัจกัรหนำ้ท่ี 20% 

ทดลองท ำกำรวดัสัญญำณพีดบัเบิ้ลยเูอม็ท่ีวฏัจกัรหนำ้ท่ี 50% 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.14  สัญญำณพีดบัเบิ้ลยเูอม็ท่ีวฏัจกัรหนำ้ท่ี 50% 
 3.2.2  กำรเขียนโปรแกรมแลปววิ 

3.2.2.1  กำรเขียนโปรแกรมติดต่อระหวำ่งไมโครคอนโทรลเลอร์กบัโปรแกรมแลปววิ 
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รูปที ่3.15  แสดงกำรต่อ VISA เพื่อติดต่อกบัไมโครคอนโทรลเลอร์ 

 กำรเขียนโปรแกรมติดต่อระหว่ำงไมโครคอนโทรลเลอร์กับโปรแกรมแลปวิว จะต้อง        
ลงไดร์ฟเวอร์ NI-VISA 4.6.2 ดังรูปท่ี  3.16 เพื่ อท่ีจะท ำให้สำมำรถใช้เคร่ืองมือ VISA ได ้
เคร่ืองมือ ท่ีใช้มีทั้งหมด 4 ตวั คือ VISA Open ,VISA Read ,VISA Write และ VISA Close 

แสดงดงัรูปท่ี 3.17 VISA Open ท ำหน้ำท่ีเป็นตวัเลือกหมำยเลขพอร์ตของ USB, VISA Read 

ท ำหน้ำท่ีอ่ำนค่ำระดบัน ้ ำท่ีส่งมำจำกไมโครคอนโทรลเลอร์ VISA Write ท ำหน้ำท่ีส่งตวัอกัษร   
ไปย ังไมโครคอนโทรลเลอร์  เพื่ อให้ ส่ งค่ ำระดับน ้ ำจำกเซนเซอร์มำย ังแลปวิว และปรับ                  
%วฏัจกัรหนำ้ท่ี ของสัญญำณพีดบัเบิ้ลยเูอม็ท่ีใชใ้นกำรควบคุมมอเตอร์ป๊ัม 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.16  ไดร์ฟเวอร์ NI-VISA 4.6.2 
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รูปที ่3.17  เคร่ืองมือ VISA 

3.2.2.2  กำรเขียนโปรแกรมควบคุมระดบัน ้ำโดยใชต้วัควบคุมแบบฟัซซี (Fuzzy- 

Controller) 
 
 
 
 
 
 
 
 

รูปที ่3.18  กำรต่อใชง้ำนตวัควบคุมแบบฟัซซี 
 รูปท่ี 3.18 แสดงกำรต่อใช้งำนตวัควบคุมแบบฟัซซี ค่ำจุดก ำหนดจะได้จำก   
กำรเล่ือนแถบแสดงผลท่ีหน้ำจอ ค่ำสัญญำณป้อนกลับ (Feedback) ได้จำกเซนเซอร์ควำมดัน         
ท่ีรับค่ำมำจำกไมโครคอนโทรลเลอร์ ค่ำผิดพลำดได้จำกกำรน ำค่ำจุดก ำหนดลบกับสัญญำณ
ป้อนกลับ  ส่วนค่ำความผิดพลาดท่ี เปล่ียนแปลงได้จำกกำรน ำค่ำผิดพลำดปัจจุบันลบกับ                 
ค่ำผดิพลำด เดิมท่ีไดจ้ำก Feedback Node 
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 ตัวควบคุมแบบฟัซซีอยู่ในแถบเคร่ืองมือ Control Design & Simulation 
แสดงดงัรูปท่ี 3.19  

 
 
 
 
 
 

 
รูปที ่3.19  เคร่ืองมือตวัควบคุมแบบฟัซซี 

ก)  กำรสร้ำงตวัควบคุมฟัซซีแบบ 3 สมำชิก (Membership) 

เร่ิมจำกกำรสร้ำงไฟล์นำมสกุล .fc โดยกำรท ำตำมขั้นตอนดงัรูปท่ี 3.20 
โดยกำรคลิกท่ี  เมนู Tools > Control Design and Simulation > Fuzzy Logic Controller- 

Design จำกนั้นจะพบหน้ำต่ำงดังรูปท่ี 3.21 ท่ีเมนูให้เลือก File > New จำกนั้นจะพบหน้ำต่ำง     
ดังรูป ท่ี  3.22 ซ่ึ งหน้ำต่ำงน้ี เรำสำมำรถปรับเป ล่ียนรูปทรงของฟังก์ชันควำมเป็นสมำชิก 
(Membership Function) รวม ทั้ ง ข อบ เข ต ข อ งค่ ำข อ งตั ว แป ร  (e), (ce) แล ะ  (output)             

เม่ือปรับแต่งเสร็จส้ินให้คลิกท่ีปุ่ม Quit เพื่อไปยงัหน้ำต่ำงกำรตั้งฐำนกฎของฟัซซี (Fuzzy Rule- 

Base) ดงัรูปท่ี 3.23 ในหนำ้ต่ำงน้ีเรำสำมำรถปรับฐำนกฎของฟัซซี และรูปแบบกำรดีฟัซซิฟิเคชนั 
(Defuzzification) ได ้ซ่ึงรูปแบบของฟังก์ชนัควำมเป็นสมำชิก และกำรตั้งฐำนกฎของฟัซซีท่ีใช้
ในโครงงำนน้ีแสดงดงัรูปท่ี 3.24 - 3.27 

 
 
 
 
 
 
 
 

 
รูปที ่3.20  แสดงขั้นตอนกำรเปิดหนำ้ต่ำงกำรสร้ำงไฟลน์ำมสกุล .fc 
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รูปที ่3.21  แสดงขั้นตอนกำรสร้ำงไฟลน์ำมสกุล .fc 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที ่3.22  แสดงหนำ้ต่ำงกำรสร้ำงฟังกช์นัควำมเป็นสมำชิก 

9 

8 

2 
1 

3 
4 
5 
6 

10 

7 
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 หมายเลข 1 แสดงช่ือของตวัแปรภาษาดา้นอินพุทและเอาตพ์ุตของตวัควบคุมแบบฟัซซี 
 หมายเลข 2 ใชใ้นการเลือกเพื่อปรับแต่งรูปร่างในแต่ละเทอมของฟังกช์นัควำมเป็นสมำชิก 
 หมายเลข 3 ใชใ้นการเลือกวา่จะปรับแต่งค่าในส่วนท่ีเป็นตวัแปรอินพุทหรือเอาตพ์ุต 
 หมายเลข 4 ใชใ้นการเปล่ียนช่ือตวัแปรอินพุท, เอาตพ์ุต, เทอมของฟังกช์นัควำมเป็นสมำชิก 

และปรับค่าขอบเขตของฟังก์ชนัควำมเป็นสมำชิก 
 หมายเลข 5 ใชใ้นการเพิ่มหรือลด จ านวนตวัแปรดา้นอินพุต, เอาตพ์ุต และจ านวนเทอมของ 
ฟังกช์นัควำมเป็นสมำชิก 

 หมำยเลข 6 ใชใ้นกำรปรับเปล่ียนรูปแบบของฟังกช์นัควำมเป็นสมำชิก 

 หมำยเลข 7 แสดงระดบัค่ำควำมเป็นสมำชิกมีค่ำระหวำ่ง 0 – 1 

 หมำยเลข 8 แสดงค่ำขอบเขตของฟังกช์นัควำมเป็นสมำชิก ซ่ึงสำมำรถปรับเปล่ียนค่ำไดใ้น
แถบเคร่ืองมือหมำยเลข 4 

 หมำยเลข 9 แสดงแถบท่ีใชก้ำรเล่ือนปรับรูปร่ำงของฟังก์ชนัควำมเป็นสมำชิก 

 หมำยเลข 10 ใชใ้นกำรออกจำกหนำ้ต่ำงกำรปรับแต่ง 
 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.23  แสดงหนำ้ต่ำงกำรสร้ำงฐำนกฎของฟัซซี 

 หมายเลข 1 ใชใ้นการปรับแต่งฐานกฎของฟัซซี 
 หมายเลข 2 ใชใ้นการปรับวธีิการดีฟัซซิฟิเคชนั 
 หมายเลข 3 ใชใ้นการปรับวธีิอนุมาน (Inference) 

3 

2 

1 
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รูปที ่3.24  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรอินพุต (E) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปที ่3.25  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรอินพุต (CE) 
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รูปที ่3.26  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรเอำตพ์ุต (out) 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.27  แสดงลกัษณะกำรตั้งฐำนกฎของฟัซซีแบบ 3 สมำชิก 
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ข)  การสร้างตวัควบคุมฟัซซีแบบ 5 สมาชิก 
 การสร้างตวัควบคุมฟัซซีแบบ 5 สมาชิก มีขั้นตอนการสร้างเหมือนกับ    
ตวัควบคุมแบบ 3 สมาชิก ทุกอย่าง แต่แตกต่างกนัท่ีเราตอ้งท าการเพิ่มจ านวนเทอมของฟังก์ชัน
ความเป็นสมาชิก ตามขั้นตอนดงัน้ี 
 ขั้นตอนท่ี 1 เลือกเทอมของฟังกช์นัความเป็นสมาชิกท่ีอยูต่รงกลางดงัรูปท่ี 3.28 
 ขั้นตอนท่ี 2 คลิกท่ีแถบเคร่ืองมือ define > add term after เพื่อท าการเพิ่มจ านวนสมาชิก 
ตวัแรก จะไดผ้ลลพัธ์ดงัรูปท่ี 3.29 
 ขั้นตอนท่ี 3 เลือกเทอมของฟังกช์นัความเป็นสมาชิกท่ีอยูต่รงกลางอีกคร้ัง ดงัรูปท่ี 3.30 
 ขั้นตอนท่ี 4 คลิกท่ีแถบเคร่ืองมือ define > add term before เพื่อท าการเพิ่มจ านวนสมาชิก 
ตวัท่ีสอง จะไดผ้ลลพัธ์ดงัรูปท่ี 3.31 

ซ่ึงรูปแบบของฟังก์ชันควำมเป็นสมำชิก และกำรตั้งฐำนกฎของฟัซซีท่ีใช้ในโครงงำนน้ี
แสดงดงัรูปท่ี 3.32 - 3.35 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.28  แสดงการเลือกเทอมกลางของฟังกช์นัความเป็นสมาชิก 
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รูปที ่3.29  แสดงผลลพัธ์หลงัจากเพิ่มจ านวนเทอมตวัแรกของฟังกช์นัความเป็นสมาชิก 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.30  แสดงการเลือกเทอมกลางของฟังกช์นัความเป็นสมาชิก 
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รูปที ่3.31  แสดงผลลพัธ์หลงัจากเพิ่มจ านวนเทอมตวัท่ีสองของฟังกช์นัความเป็นสมาชิก 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปที ่3.32  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรอินพุต (E) 



65 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปที ่3.33  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรอินพุต (CE) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปที ่3.34  แสดงลกัษณะฟังกช์นัควำมเป็นสมำชิกของตวัแปรเอำตพ์ุต (out) 
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รูปที ่3.35  แสดงลกัษณะกำรตั้งฐำนกฎของฟัซซีแบบ 5 สมำชิก 

3.2.2.3  กำรเขียนโปรแกรมควบคุมระดบัน ้ำโดยใชต้วัควบคุมแบบเปิดปิด (ON-OFF- 

Controller) 
   
  
 
 
 
 
 
 
 

รูปที ่3.36  กำรต่อใชง้ำนตวัควบคุมแบบเปิดปิด 
 รูปท่ี 3.36 แสดงกำรต่อใชง้ำนตวัควบคุมแบบเปิด-ปิด เน่ืองจำกตวัควบคุมแบบ
เปิด-ปิด ไม่มีให้เลือกใช้งำนในโปรแกรมแลปวิว จึงเลือกใชเ้คร่ืองมือตวัเปรียบเทียบแทน และใช้
ตวั Selector ส่งค่ำเอำต์พุต (Output) โดยหำกค่ำจุดก ำหนดมีค่ำน้อยกว่ำหรือเท่ำกบัค่ำสัญญำณ
ป้อนกลบั จะส่งค่ำ  0 ออกท ำให้มอเตอร์ป๊ัมหยุดหมุน แต่หำกค่ำจุดก ำหนด มีค่ำมำกกว่ำสัญญำณ
ป้อนกลบัจะส่งค่ำ 100 ออกไปท ำให้มอเตอร์ป๊ัมท ำงำนเต็มท่ี ส่วนค่ำจุดก ำหนด จะไดจ้ำกกำรเล่ือน
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แถบแสดงผลท่ีหน้ ำจอ ค่ ำสัญญำณ ป้อนกลับ  ได้จำก เซน เซอร์ควำมดัน ท่ี รับค่ ำมำจำก
ไมโครคอนโทรลเลอร์ 
 ตัวเปรียบแบบน้อยกว่ำหรือเท่ำกับ และ Selector อยู่ในแถบเคร่ืองมือ Comparison     
แสดงดงัรูปท่ี 3.37 
 
 
 
 
 
 
 
 
 

 
รูปที ่3.37  เคร่ืองมือ Comparison 

3.2.2.4  กำรเขียนโปรแกรมแสดงผลระดบัน ้ำทำงหนำ้จอ 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.38  แสดงกำรปรับค่ำระดบัน ้ำเพื่อแสดงทำงหนำ้จอ 
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 รูปท่ี 3.38 แสดงกำรเขียนโปรแกรมเพื่อปรับค่ำระดบัน ้ ำท่ีมีค่ำอยูใ่นช่วง 63 – 233 ให้ลดลง
อยูใ่นช่วง 0 – 20 จึงจะท ำให้สำมำรถน ำมำหกัลบกบัค่ำจุดก ำหนดได ้เร่ิมจากการอ่านเซนเซอร์ท่ีมี
ความยาว 12 ตวัอกัษรแลว้น ามาอ่านค่าออกเป็น 2 ชุด แลว้น ้ ามาลบกบัค่าระดบัน ้ าท่ี 0 ซม. 63 แลว้
คูณกับค่า 8.5 จะได้ระดับน ้ าในช่วง 0 – 20 หลังจำกนั้นน ำมำต่อกับตวั Selector เพื่อแสดงผล  
ระดับน ้ าถังท่ี 1 และ 2 โดย Selector จะท าการรับค่า True กับ False จากตวั Valve Select ซ่ึง
เป็นสวติช์ตวัเลือกวา่จะท าการควบคุมระดบัน ้าแบบ 1 ถงัหรือ 2 ถงั 
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แผนการด าเนินโครงงาน การสร้างชุดสาธิตการควบคุมระดับน า้ด้วยวธีิการควบคุมแบบพไีอดีและฟัซซีโดยใช้โปรแกรมแลปววิ 
(The construction of demonstration set of water level control by PID and Fuzzy controller using LabVIEW program) 

ตารางที ่3.1  แสดงระยะเวลำกำรท ำโครงงำน 

ล าดบั รายละเอยีดการท างาน 
ต.ค. 51 พ.ย. 51 ธ.ค. 51 ม.ค. 52 ก.พ. 52 ม.ีค. 52 เม.ย. 52 พ.ค. 52 ม.ิย. 52 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 
1 ศึกษำขอ้มูลเก่ียวกบัโครงงำน                                     

                                    
2 ออกแบบโครงสร้ำงถงัน ้ ำ                                     

                                    
3 จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ                                     

                                    
4 ประกอบโครงสร้ำงถงัน ้ ำ                                     

                                    
5 ออกแบบชุดไมโครคอนโทรลเลอร์และชุดไดร์ฟ                                     

                                    
6 จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ                                     

                                    
7 ประกอบชุดไมโครคอนโทรลเลอร์และชุดไดร์ฟ                                     

                                    
8 ออกแบบกล่องใส่วงจร                                     

                                    
9 สร้ำงและติดตั้งกล่องใส่วงจรเขำ้กบัชุดถงัน ้ ำ                                     

                                    
10 เขียนโปรแกรมควบคุมกำรท ำงำนดว้ยแลปววิ                                     

                                    
11 ทดลองกำรท ำงำนของระบบ                                     

                                    
12 ออกแบบใบงำน                                     

                                    
13 จดัท ำคู่มือ                                     

                                    
14 จดัท ำเล่มปริญญำนิพนธ์                                     

                                    
 แผนงำนท่ีวำงไว ้
 แผนงำนท่ีปฏิบติัจริง 69
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แผนการด าเนินโครงงาน การสร้างชุดสาธิตการควบคุมระดับน า้ด้วยวธีิการควบคุมแบบพไีอดีและฟัซซีโดยใช้โปรแกรมแลปววิ 
(The construction of demonstration set of water level control by PID and Fuzzy controller using LabVIEW program) 

ตารางที ่3.1  แสดงระยะเวลำกำรท ำโครงงำน (ต่อ) 

ล ำดับ รำยละเอยีดกำรท ำงำน 
ก.ค. 52 ส.ค. 52 ก.ย. 52 ต.ค. 52 พ.ย. 52 ธ.ค. 52 ม.ค. 53 ก.พ. 53 ม.ีค. 53 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 
1 ศึกษำขอ้มูลเก่ียวกบัโครงงำน                                     

                                    
2 ออกแบบโครงสร้ำงถงัน ้ ำ                                     

                                    
3 จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ                                     

                                    
4 ประกอบโครงสร้ำงถงัน ้ ำ                                     

                                    
5 ออกแบบชุดไมโครคอนโทรลเลอร์และชุดไดร์ฟ                                     

                                    
6 จดัซ้ืออุปกรณ์ตำมท่ีออกแบบ                                     

                                    
7 ประกอบชุดไมโครคอนโทรลเลอร์และชุดไดร์ฟ                                     

                                    
8 ออกแบบกล่องใส่วงจร                                     

                                    
9 สร้ำงและติดตั้งกล่องใส่วงจรเขำ้กบัชุดถงัน ้ ำ                                     

                                    
10 เขียนโปรแกรมควบคุมกำรท ำงำนดว้ยแลปววิ                                     

                                    
11 ทดลองกำรท ำงำนของระบบ                                     

                                    
12 ออกแบบใบงำน                                     

                                    
13 จดัท ำคู่มือ                                     

                                    
14 จดัท ำเล่มปริญญำนิพนธ์                                     

                                    
แผนงานท่ีวางไว ้
แผนงานท่ีปฏิบติัจริง 70 
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